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2024 年 5 月 Lattice Radiant 日本語ユーザーガイ ド

註 ： 本 Lattice Radiant 日本語マニュアルは、 日本語によ る理解のため一助 と して提供しています。 作成にあたっては各 ト ピ ッ クについて可能な限 り 正確を期してお
り ますが、 必ずし も網羅的あるいは最新でない可能性や、 オ リ ジナル英語版オン ラ イ ンヘルプや各種ド キュ メ ン ト と不一致がある可能性があ り 得ます。 疑義が生じ
た場合は技術サポー ト 担当者にお問い合わせ頂 く か、 または最新の英語オ リ ジナル ・ ソース を参照する よ う にお願い致し ます。

　

 第 5 章 　 論理合成プロセス

5.1 論理合成ツールについて
　 Lattice Radiant の論理合成ツールには Lattice Synthesis Engine （以下 LSE） と Synplify Pro for Lattice （以下
Synplify Pro） があ り ます。 LSE が新規プロ ジェ ク ト 作成時のデフ ォル ト ですが （図 2-7 参照）、 既存プロ ジェ
ク ト でも指定を変え る こ と ができ ます（第 2.2.4.2 項に関連記述）。2023.2 では Synplify Pro がデフ ォル ト です。

5.1.1 論理合成ツールの選択

　 論理合成ツールはイ ンプ リ メ ンテーシ ョ ンご と に指定でき ますが、 プロ ジェ ク ト 作成後にツールを変更す
る方法は幾つかあ り ます。 第一の方法では、 まずア ク テ ィ ブな イ ンプ リ メ ンテーシ ョ ン名を選択後右ク リ ッ
ク し、 [Select Synthesis Tool...] または [Properties] を選択し ます （図 5-1）。

図 5-1. 論理合成ツールの変更操作 １

　 表示される ”Project Properties” ウ ィ ン ド ウで、 左枠でア ク テ ィ ブな イ ンプ リ メ ンテーシ ョ ンが選択されて
いる状態で、 右枠表内 Name カ ラ ムの ”Synthesis Tool” 行に、 その時点で選択されている論理合成ツールが表
示されます。 [Value] カ ラ ムのど こかを ク リ ッ クする と、 プルダウ ン形式で選択可能なツール名が表示されま
す （Synplify Pro と LSE）。 所望のツールを選択後、 『OK』 ボタ ンを ク リ ッ ク し ます。

図 5-2. 論理合成ツールの変更方法 ２

　 別の方法と し て、Radiant の メ ニューバーから [Project] → [Active Implementation] → [Select Synthesis Tool...]
を選択し ます （図 5-2）。 図 5-1 と同じプロパテ ィ ・ ウ ィ ン ド ウが表示されますので、 同様に行います。
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5.1.2 論理合成制約フ ァ イルの取 り 込み

　 一般的なフ ローでは、 論理合成用ス ト ラ テジーの各オプシ ョ ン設定がデザイ ン全体 （グ ローバル） に適用
されます。 例えば、 デザイ ンに 25MHz と 125MHz の二系統の ク ロ ッ ク があ る場合で も、 ス ト ラ テジーの
Frequency 制約と し て 125MHz を与え る と、 両方に適用される動作にな り ます。

　 一方、論理合成ツール用の設計制約フ ァ イル (Pre-Synthesis Constraint File) を用いる こ と で、 よ り 詳細なコ
ン ト ロールが可能にな り ます。 この例の場合、 25MHz のク ロ ッ ク には 25MHz を、 125MHz のク ロ ッ ク には
125MHz の制約 と い う よ う に、 ク ロ ッ ク ネ ッ ト ご と に個別に周波数制約を与え る こ と が可能です。 制約フ ァ
イルがな く て も Radiant フ ローの処理自体には支障あ り ませんが、 論理合成結果は異な り ます。

図 5-3. 既存の論理合成制約フ ァ イルのイ ンポー ト

　 プロ ジェ ク ト 作成時は論理合成制約フ ァ イルがない状態です。 作成済み論理合成制約フ ァ イルを イ ンポー
ト する場合は、 メ ニューバーから [File] → [Add] → [Existing File...] と選択するか、 ”File List” ウ ィ ン ド ウ内
[Pre-Synthesis Constraint Files] 行か、 その下にあ る [Lattice LSE] 行か [Synplify Pro] 行をのいずれかを選択後
に右ク リ ッ ク し [Add] → [Existing File...] を選択し ます （図 5-3）。

図 5-4. イ ンポー ト する制約フ ァ イルの選択
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　 フ ァ イル・イ ンポー ト のウ ィ ン ド ウ（Add Existing File）が立ち上が り まず。図 5-4 は [Pre-Synthesis Constraint
Files] 行を選択し た場合の例で、 「File of Type」 は ”*.sdc” が選択 さ れています。 こ こ では示し ませんが、
[Lattice LSE] 行の場合は ”*.ldc” が、[Synplify Pro] 行の場合は ”*.fdc” がフ ァ イルタ イプにな り ます。このバー
を ク リ ッ クする こ と で、 自動選択されている拡張子は変更する こ と ができ ます。 ブラ ウズ し て適切なフ ァ イ
ルを選択後、 『Add』 ボタ ンを ク リ ッ ク し ます。

　 この と き、 ウ ィ ン ド ウ下部の 「Copy file to directory」 ボタ ンにチェ ッ ク を入れる と、 その右セルで指定す
る フ ォルダーにコ ピーされ、 それを イ ンポー ト し ます。 デフ ォル ト はチェ ッ ク が入っていない状態で、 選択
フ ァ イルを コ ピーせずに、 そのま ま イ ンポー ト し ます。

　 各イ ンプ リ メ ンテーシ ョ ンには複数の論理合成制約フ ァ イルを イ ンポー ト でき ますが、ア ク テ ィ ブ （有効）
な ものは唯一です。 ア ク テ ィ ブな制約フ ァ イルは太字で、 非ア ク テ ィ ブな制約フ ァ イルはグレーで表示され
ます。

　 ア ク テ ィ ブ化と非ア ク テ ィ ブ化の切 り 替えは、 意図する フ ァ イルをを ク リ ッ ク し て選択し、 右ク リ ッ クす
る と表示されるプルダウ ンから [Set as Active] または [Set as Inactive] を選択し ます。 制約フ ァ イルは削除で
き ます。 同様に選択後に右ク リ ッ ク で [Remove] を選択するか、 選択し た状態でキーボード の 『Delete』 キー
を押し ます。 ” プロ ジェ ク ト から削除 ” はイ ンポー ト 情報の削除で、 フ ァ イル自体の削除ではあ り ません。

5.2 LSE

5.2.1 ス ト ラ テジー ・ オプシ ョ ン項目

　 GUI 左側のフ ァ イル リ ス ト ・ ビ ューの上部は 「Strategies」 セ ク シ ョ ンで、 プロ ジェ ク ト で定義されている
ス ト ラ テジーの一覧が表示されています。 太字表示が、 イ ンプ リ メ ンテーシ ョ ンに適用される ア ク テ ィ ブな
ものです。 論理合成ツール と し て LSE を指定し ている状態でス ト ラ テジー名をダブルク リ ッ クする と、 LSE
のス ト ラ テジー設定ウ ィ ン ド ウが開き ます （図 5-5）。

図 5-5. LSE のス ト ラ テジー設定ウ ィ ン ド ウ

　 以降に個々のス ト ラ テジー ・ オプシ ョ ンについて記述し ます。 オ リ ジナルはオン ラ イ ンヘルプ [Reference
Guide] → [Strategy Reference Guide] → [LSE Options] と選択する こ と でご参照いただけます。
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Allow Duplicate Modules

パラ メ ータ : True / False デフ ォル ト ： False

同一モジュールが重複し ている場合、 デフ ォル ト ではエラーにな り 、 処理を終了し ます。 [True] の場
合はウ ォーニングを出力し ますが、 モジ ュール定義の最後の も のを用いて処理を行います （それ以前
の定義は用いません）。

Allow Mixed Assignments

パラ メ ータ :  True / False デフ ォル ト ： False

[True] にする と ノードへのブロ ッ キング と ノ ンブロ ッ キング代入を許可し、ウ ォーニングを生成し ま
す。

Carry Chain Length

パラ メ ータ : 数値 デフ ォル ト 値 ： 0 （制限な し）

カ ウ ン ターや演算回路で使用される キ ャ リ ー （桁上が り ／下が り ） チェ イ ン ・ プ リ ミ テ ィ ブ CCU
（Carry Chain Cells） の使用数に関するオプシ ョ ンで、 単一キ ャ リ ー ・ チェ イ ンの最大数を指定し ます。

この設定は [Use Carry Chain] オプシ ョ ンが [True] の場合のみ有効です。

Command Line Options

パラ メ ータ : 文字列 デフ ォル ト ： ブラ ン ク

GUI の リ ス ト に表示されていない特別なオプシ ョ ンを使用する場合に、直接引数等を記述し ます。 コ
マン ド の詳細についてはオン ラ イ ンヘルプの [Running SYNTHESIS from the Command Line] 項をご参照
く ださい （[Reference Guides] → [Command Line Reference Guide] → [Command Line Tool Usage]）。

DSP Style

パラ メ ータ : DSP / Logic デフ ォル ト ： DSP

演算機能の実装方法を指定し ます。 デフ ォル ト は DSP マ ク ロ を使用し、 [Logic] では汎用ロジ ッ ク
（LUT+FF） を使用し ます。

DSP Utilization

パラ メ ータ : 数値 デフ ォル ト 値 ： 100

DSP マ ク ロ使用率 [%] の上限値を指定し ます。

Decode Unreachable States

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と、 FSM （ステー ト マシン） が未定義ステー ト に遷移し た場合の動作記述 （Verilog の
”default”/VHDL の ”others” ステー ト ） を残し ます （セーフ ・ リ カバ リ ー動作）。

Disable Distributed RAM

パラ メ ータ : True / False デフ ォル ト ： False

ボ ッ ク ス をチェ ッ ク し て[True]にする と、メ モ リ ー推論記述RTLで分散 メ モ リ ー（Distributed Memory）
を使用せずに、 EBR を用います。

EBR Utilization

パラ メ ータ : 数値 デフ ォル ト 値 ： 100

EBR 使用率 [%] の上限値を設定し ます。 設定し た値を超え る場合、 残 り は分散 メ モ リ ー （Distributed
Memory） で実現されます。

FSM Encoding Style

パラ メ ータ : Auto / Binary / Gray / One-Hot デフ ォル ト ： Auto

FSM のステー ト ・ エン コード方式に関する設定で、 Auto （デフ ォル ト ） では、 RTL 記述ステー ト 数
から LSE が決定し ます。 Auto 以外では、 その指定に従ったエン コード の FSM が生成されますが、 Gray
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　 は 4 ステー ト 未満でのみ指定が有効です。

Fix Gated Clocks

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト では、 RTL 記述でゲーテ ィ ング し ている ク ロ ッ ク信号を、 FPGA 実装に適する構成に変換
し ます。 ただし、 対象ク ロ ッ クは *.ldc フ ァ イルに ”create_clock” 制約で明記されている必要があ り ま
す。 また、 変換するためには全てのゲーテ ィ ング論理が分解でき る こ と、 など一定の条件があ り ます。
変換でき ない場合は、 スキ ューの大きいク ロ ッ ク ネ ッ ト と し て実装されますので、注意が必要です （基
本的にク ロ ッ ク ・ ゲーテ ィ ングはし ないこ と が重要です）。

変換された ク ロ ッ ク と関連情報はロ グフ ァ イル ”synthesis.log” に書き出されます。

Force GSR （iCE40 UP を除 く ）

パラ メ ータ : Auto / True / False デフ ォル ト ： False

GSR （Global Set/Reset） 使用に関し て、 [True] では GSR バッ フ ァ を使用し、 [False] では使用し ませ
ん。 [Auto] では自動的に判断し ます。 2023.1 までのデフ ォル ト Auto が 2023.2 では変更されています。

Ignore Constraint Errors

パラ メ ータ :  True / False デフ ォル ト ： False

デフ ォル ト では制約記述にエラーがあ る と処理を終了し、 エラー メ ッ セージを出力し ます。 [True] で
はエラー記述は無視し、 処理を継続し ます。

Intermediate File Dump

パラ メ ータ :  True / False デフ ォル ト ： False

[True] にする と暗号化 Verilog HDL フ ァ イルを出力し ます （拡張子 *.ve）。 デフ ォル ト （False） では
出力されません。 何ら かの問題が生じ た際などに、 デザイ ンの ソース記述を開示せずにブ ラ ッ ク ボ ッ
ク ス と し て提供し、 Lattice から技術支援を受ける こ と ができ ます。

Loop Limit

パラ メ ータ : 数値 デフ ォル ト 値 ： 1950

RTL ソース記述内の ”for” や ”while” ループ回数の最大値を設定し ます。 ループ ・ イ ンデッ ク スが定
数ではな く 変数と し て定義されている場合にのみ適用されます。 小さすぎ る値は無視されます。 大き
過ぎ る と、 ス タ ッ ク ・ オーバーフ ローを生じ る可能性があ り ますので、 ご注意 く ださい。

Macro Search Path

パラ メ ータ : フ ォルダーパス デフ ォル ト ： ブラ ン ク

デザイ ンで IP コ アなどのマ ク ロ フ ァ イル （*.ngo） を使用し ている場合のみ、 そのフ ォルダーパス を
指定し ます。 ただしプロ ジ ェ ク ト ・ フ ォルダーかイ ンプ リ メ ンテーシ ョ ン ・ フ ォルダーに当該フ ァ イ
ルがあ る場合、或いは RTL 内で *.ngo フ ァ イルの（相対パスではな く ）絶対パス を ”FILE” ア ト リ ビ ュー
ト 指定で明記し ている場合は、 こ こで指定する必要はあ り ません。

　 　 複数のフ ォルダーを指定する場合は、 ” ； ” で区切 り ます （間にスペースは入れない）。 パスの記述は
相対パスでも有効です。

Max Fanout Limit

パラ メ ータ : 最大フ ァ ンア ウ ト 数 デフ ォル ト 値 ： 1000

フ ァ ンア ウ ト 上限数を制約し ます。 フ ァ ンア ウ ト が こ の値を超えた場合は、 ド ラ イバーを複製し て
フ ァ ンア ウ ト 数を減ら し ます。

Memory Initial Value File Search Path

パラ メ ータ : フ ォルダーパス デフ ォル ト ： ブラ ン ク

EBR （ブロ ッ ク メ モ リ ー） の初期値設定を行 う 際に、 初期値を記述し たフ ァ イル （*.mem） が保存さ
れている フ ォルダーパス を指定し ます。何も指定し ない場合は、 イ ンプ リ メ ンテーシ ョ ン ・ フ ォルダー
が参照されます。 EBR の初期値設定を行わない場合は、 記述する必要はあ り ません。 また、 モジ ュー
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ル生成ツールで生成する際に初期化フ ァ イルを指定し ている場合は、 こ こ で再度指定する必要はあ り
ません。

Optimization Goal

パラ メ ータ : Area / Timing 　 　 デフ ォル ト ： Timing

デフ ォル ト [Timing] はロ ジ ッ ク段数を少な く する速度重視で最適化し ます。*.ldc に ”create_clock” で
制約が記述されている場合、 [Target Frequency] オプシ ョ ンは無視し ます。

[Area] は使用 リ ソース数が少な く なる よ う に最適化し ます。[Use IO Registers] オプシ ョ ンが [Auto] に
なっている場合、 入出力レジス ターは I/O パッ ド セルのものを使用し ます。

Propagate Constant

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト は （論理やモジュールの） 入力に固定値になっている場合に、 関連する回路を最適化 （削
除） し ます。 [False] を選択する と、 回路は最適化されずに残 り ます。

RAM Style

パラ メ ータ : Auto / Block_RAM / Distributed / Registers デフ ォル ト 値 : Auto

RAM を推定する場合の実現方法 （ リ ソース） を設定し ます。 [Block RAM] では EBR が、 [Distributed]
は分散 RAM が、 [Registers] ではフ リ ッ プフ ロ ッ プがそれぞれ使用されます。 デフ ォル ト は LSE が最適
な ものを選択し ます。

ROM Style

パラ メ ータ : Auto / EBR / Logic デフ ォル ト ： Auto

ROM を推定する場合の実現方法を設定し ます。 [EBR] では EBR を使用し、 [Logic] では分散 メ モ リ ー
かス ラ イ ス内のロ ジ ッ ク リ ソースで構成し ます。 デフ ォル ト は LSE が最適な ものを選択し ます。

Remove Duplicate Registers

パラ メ ータ : True / False デフ ォル ト ： True

全 く 同じ機能 （論理） のフ リ ッ プフ ロ ッ プが複数あ る場合、 デフ ォル ト は冗長な分を最適化 （削除）
し て リ ソース数を削減し ます。 [False] では削除せずに残し ます。

Remove LOC Properties

パラ メ ータ : On / Off デフ ォル ト ： Off

RTL ソース内記述の配置制約 （LOC） に関し て、 [On] にする と その指定は削除されます。

Resolve Mixed Drivers

パラ メ ータ : True / False デフ ォル ト ： False

[True] を選択する と、 特定のネ ッ ト がア ク テ ィ ブな信号と VCC （または GND） から共に ド ラ イブさ
れている場合、 VCC （または GND） に固定し ます。

Resource Sharing

パラ メ ータ : True / False デフ ォル ト ： True

同一機能の回路が複数あ る場合、 使用 リ ソース数を減ら し て共用する回路を生成 （ リ ソース ・ シェア
リ ング） し ます。 [False] ではこの処理は行いません。

Target Frequency (MHz)

パラ メ ータ : 数値 （周波数） デフ ォル ト 値 ： 200

ク ロ ッ ク周波数 （MHz） ターゲ ッ ト の設定で、 デザイ ン内に複数のク ロ ッ ク があ る場合でも、 全てが
対象 と な り ます。 LDC 制約で個別に指定し ている ク ロ ッ ク には適用されません。

Use Carry Chain

パラ メ ータ : True / False デフ ォル ト ： True
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カ ウ ン ターや演算回路に含まれる加算器に関し て、 キ ャ リ ー （桁上が り ／下が り ） チェ イ ンの使用を
イネーブルし ます。 [False] では使用し ません。

Use IO Insertion

パラ メ ータ : True / False デフ ォル ト ： True

論理合成時に IO パッ ド と GSR を挿入し ます。 [False] では挿入し ません。

Use IO Registers

パラ メ ータ :Auto / False / True デフ ォル ト ： Auto

[Tue] ではタ イ ミ ング制約を踏まえて、 I/O パッ ド セル内の I/O レジス タ を使用する こ と を強制し ま
す。 [False] では I/O レジス タ を使用し ません。 デフ ォル ト （Auto） では、 [Optimization Goal] オプシ ョ
ンが [Area] の場合に I/O レジス タ を使用し ますが、 [Timing] では使用し ません。

VHDL 2008

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と、 VHDL 言語仕様 と し て VHDL 2008 を適用し ます。

5.2.2 LSE 制約フ ァ イルの生成

　 LSE 用の論理合成制約フ ァ イル *.ldc はブラ ン ク状態から作成でき ますが、 これは LDC 書式に習熟し てい
る場合にのみ推奨し ます。 基本的にはタ イ ミ ング制約エデ ィ ター （Timing Constraint Editor: TCE） を用いる
こ と をお勧めし ます。 詳細については第 15 章をご参照 く ださい。

　 新規作成は、 メ ニューバーから [File] → [New] → [File...] の順に選択する と表示される 「New File」 ウ ィ ン
ド ウで [LSE Design Constraints Files] を選択し て （フ ァ イル名を入力後に） 開始し ます。 または、 イ ンプ リ メ
ンテーシ ョ ンのフ ァ イル リ ス ト （File List） 枠内 「Pre-Synthesis Constraint Files」 セ ク シ ョ ン下 「Lattice LSE」
を選択後に右ク リ ッ ク し て [Add] → [New 　 File...] と選択し て も 「New File」 ウ ィ ン ド ウが表示されます。

5.2.3 ネ ッ ト リ ス ト ・ アナラ イザー

　 LSE を論理合成に選択し た場合、回路情報をグ ラ フ ィ カルに閲覧する ツールがネ ッ ト リ ス ト ・アナラ イザー

です。 起動するにはア イ コ ンバーの中の を ク リ ッ クするか、 メ ニューから [Tools] → [Netlist Analyzer]
を選択し ます。

図 5-6. ネ ッ ト リ ス ト ・ アナラ イザーの表示例 と ア イ コ ン
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　 起動後の表示 （デタ ッチし たウ ィ ン ド ウ） は図 5-6 の例のよ う にな り 、 RTL View スケマテ ィ ッ ク が表示さ
れます。ア イ コ ン列はウ ィ ン ド ウの左端に並んでいて、上部には RTL View / Technology View ア イ コ ンや、階
層移動、 ページ移動などのア イ コ ンがあ り ます。 その右は リ ソース リ ス ト の表示ウ ィ ン ド ウで、 Instances /
Ports / Nets / Clocks の 4 つに分かれています。図 5-6 は Instances と Clocks 行先頭の ▶ を ク リ ッ ク し て展開
し た状態の例です。 他も同様に展開し て意図する リ ソース を選択する と、 スケマテ ィ ッ ク内で当該 リ ソース
が赤色でハイ ラ イ ト されます。

　 デザイ ンの実装は階層構造にするのが一般的ですが、 モジュール階層の上下移動のア イ コ ンを ク リ ッ ク し
てから、 スケマテ ィ ッ ク表示内の （サブ） モジュールの箱の上にア イ コ ンを移動する と、 下位階層があ る場
合はア イ コ ンが下向き青矢印表示にな り ます。 ク リ ッ クする と 下位階層のス ケマテ ィ ッ ク表示にな り ます。
上位階層への移動は何も回路素子がない位置にア イ コ ンを移動する事で、 上向き緑矢印が表示されますので
これを ク リ ッ ク し て戻る こ と ができ ます。

5.2.3.1 オブジ ェ ク ト のサーチ

　 特定の リ ソースやネ ッ ト を探す と きのサーチ機能があ り ます。 ス ケマテ ィ ッ ク内ブラ ン ク領域にマウ ス ・
ポイ ン ターを移動し、 右ク リ ッ クする と表示される メ ニューから [Find...] を選択し ます。

図 5-7. Find ダ イ ア ロ グの起動

図 5-8. Find Dialog ウ ィ ン ド ウ
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　 表示される ウ ィ ン ド ウ （図 5-8） で、 まず①上部タブ [instances] / [Symbols] / [Nets] / [Ports] から意図す
る対象 リ ソース を選択し ます。 次に② ”Search” セ ク シ ョ ンでサーチ対象の階層を指定し ます。 デフ ォル ト は
”Current Level Only” （ダ イ ア ロ グを立ち上げた際にマウ ス ク リ ッ ク し た階層） です。 その後、 ③左側に表示
される対象候補を選択し て矢印 『->』 などを操作し て ”Highlight” 枠に移動させて 『Close』 を ク リ ッ ク し ま
す。 各矢印で選択指定と解除を適宜行います。

5.3 Synplify Pro

5.3.1 ス ト ラ テジー ・ オプシ ョ ン項目

　 オプシ ョ ン設定ウ ィ ン ド ウの起動と操作方法は LSE と同じです （図 5-5 参照）。 以降にス ト ラ テジー ・ オ
プシ ョ ンの意味について記述し ます。オ リ ジナルはオン ラ イ ンヘルプ [Reference Guide] → [Strategy Reference
Guide] → [Synplify Pro Options] と選択する こ と でご参照頂けます。

Allow Duplicate Modules

パラ メ ータ : True / False デフ ォル ト ： False

同一モジュールの重複時、 デフ ォル ト では処理を終了し ます。 [True] にする と処理を継続し ます。

Area

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と [Frequency] オプシ ョ ンの設定値を無効にし、 使用 リ ソースが最少と なる よ う に回路
を最適化し ます。 *.sdc/*.fdc 制約フ ァ イルで ク ロ ッ ク周波数 （周期） を制約し ている場合は、 その設
定が優先されます。

Arrange VHDL Files

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト では VHDL フ ァ イルのコ ンパイル順を自動的に操作し ます。 [False] にする と Radiant の
フ ァ イル リ ス ト ・ ビ ューで表示されている順に、 上から コ ンパイルされます。

Auto Compile Point （Avant フ ァ ミ リーのみ）

パラ メ ータ : True / False デフ ォル ト ： True

コ ンパイル ・ ポイ ン ト （compile point） はイ ン ク リ メ ン タル ・ デザイ ンフ ローに関する機構です。 デ
フ ォル ト では階層構造の下位モジ ュールが変更された場合に、 その上位モジ ュールも再合成するかど
う かを、 階層構造 と リ ソース使用度を評価し て自動的に判断し ます。

Automatic Read/Write Check Insertion for RAM

パラ メ ータ : True / False デフ ォル ト ： False

推論記述の RAM に関し て、 [True] にする と、 同一ア ド レ スに リ ード と ラ イ ト 同時ア ク セスが生じ る
場合のシ ミ ュ レーシ ョ ン ・ ミ スマ ッチを防ぐため、 グルーロ ジ ッ ク を生成し て挿入し ます。

Clock Conversion

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と、 ゲーテ ッ ド ・ ク ロ ッ クや分周ク ロ ッ ク の記述に対し て、 ク ロ ッ ク ・ イネーブルを用
いる回路に変換し ます。 ただし、 こ のオプシ ョ ンの指定だけでは不十分で、 以下の制約を与え る必要
があ り ます。 ツールに と っては何か ソース ク ロ ッ ク で、 ゲー ト 後の ク ロ ッ ク と の関係がど う なのかが
わから ないためです ：

　 ・ ゲーテ ィ ングする対象のソース ク ロ ッ ク が何かを明示的に指定する （create_clock）

　 ・ ゲ ー テ ィ ン グ 後 の ク ロ ッ ク ネ ッ ト と、 ソ ー ス ク ロ ッ ク の 関 係 を 明 示 的 に 指 定 す る
（create_generated_clock、 divide_by/multiply_by）

　 例えば ”clk” と い う ソース ク ロ ッ ク に対し て AND ゲー ト を通し て ”gclk0” と い う 名称のク ロ ッ ク ネ ッ
ト を回路で用いる場合の例では、 以下を制約フ ァ イル *.fdc に記述し ます ：
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　 create_clock -name {clk} {n:clk} -period {10}

　 create_generated_clock -source {n:clk} {n:gclk0} -divide_by 1

　 　 よ り 詳細については Radiant イ ン ス ト ール ・ フ ォ ルダ下に あ る Synplify Pro のユーザーガ イ ド
（C:/lscc/radiant/2023.2/synpbase/doc/fpga_user_guide.pdf） をご参照 く ださい。

Command Line Options

パラ メ ータ : 文字列 デフ ォル ト ： ブラ ン ク

GUI の リ ス ト に表示されていない、 特別なオプシ ョ ンを指定する場合に記述し ます。

Default Enum Encoding

パラ メ ータ : Default / Gray / Onehot / Sequential デフ ォル ト ： Default

VHDL の列挙 （enum） 型変数が定義されている場合、 その実装形式に関する設定です。 デフ ォル ト
（Default） では メ ンバー数に応じ て自動的に割 り 振られます。 4 以下では ”Sequential”、 40 以上では
”Gray”、 それ以外は ”Onehot” です。

[Gray] では各 メ ンバーに一度の変化で 1 ビ ッ ト のみが変化する よ う な値が割 り 当て られ（例 :000, 001,
011, 111, 110, 010）、 [Sequential] では一度に複数 bit が変化する よ う な値 （基本的にはバイナ リ ー ・ カ
ウ ン ター） が割 り 当て られます。 [Onehot] では各 メ ンバに全ビ ッ ト 中 1 ビ ッ ト のみが '1' と なる値が割
り 当て られます （例 :0001, 0010, 0100, 1000）。

Disable IO Insertion

パラ メ ータ : True / False デフ ォル ト ： False

デフ ォル ト では論理合成時に IO パッ ド を挿入し ます。 [True] にする と I/O パッ ド のないネ ッ ト リ ス
ト を生成し ますが、 マ ッ ピング以降の通常の処理には使用でき ませんので、 ご注意 く ださい。 ユーザー
モジュールのブラ ッ ク ボ ッ ク ス化など、 意図する場合のみ [True] にし ます。

Disable Register Replication during S/R Optimization (iCE40 UP を除 く ）

パラ メ ータ : True / False デフ ォル ト ： False

デフ ォル ト でシフ ト レジス ターの推論記述で RAM を生成し た場合に、 ア ド レ スポイ ン ターを複製し
ます。 [True] にする と複製し ません。

Export Radiant Settings to Synplify Pro GUI

パラ メ ータ : No / Only on First Launch / Yes デフ ォル ト ： Yes

Synplify Pro GUI を Tools メ ニューやア イ コ ンから立ち上げて論理合成を行 う 場合に、ス ト ラ テジー設
定各オプシ ョ ンをどのよ う に渡す （エ ク スポー ト する） かを指定するオプシ ョ ンです。

デフ ォル ト では、Synplify Pro GUI が起動される ご と にス ト ラ テジー設定を渡し、それ以前のセ ッ シ ョ
ンで保存されている設定は無効にな り ます。 [Only on First Launch] では、 初回起動時のみにス ト ラ テ
ジー設定を渡し、 それ以後はそのセ ッ シ ョ ンでの設定やデフ ォル ト を用いて起動し ます。 [No] は渡し
ません。

FSM Compiler

パラ メ ータ : True / False 　 　 デフ ォル ト ： True

Synplify Pro にはステー ト マシン用の解析 ・ 合成エンジンであ る FSM （Finite State Machine） コ ンパイ
ラーが組み込まれています。 デフ ォル ト では使用され、 [False] にする と使用されません。

Fanout Guide

パラ メ ータ : 最大フ ァ ンア ウ ト 数 デフ ォル ト 値 ： 1000

フ ァ ンア ウ ト 上限数を設定し ます。 フ ァ ンア ウ ト がこの値を超えた場合は、 ド ラ イバを複製し てフ ァ
ンア ウ ト を減ら し ます。

Force GSR

パラ メ ータ : Auto / False / True デフ ォル ト ： False
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論理合成時の GSR （Global Set/Reset） 使用に関する設定です。 [True] では GSR バッ フ ァ を使用し、
[False] では使用し ません。[Auto] では自動的に判断し ます。2023.1 までのデフ ォル ト Auto が 2023.2 で
は変更されています。

Frequency （MHz）

パラ メ ータ : 周波数 デフ ォル ト 値 :200

ク ロ ッ ク周波数 （MHz） ターゲ ッ ト の設定で、 [Area] オプシ ョ ンが [False] の場合のみ有効です。 デ
ザイ ン内に複数の ク ロ ッ ク があ る場合、 全てが対象 と な り ます。 *.sdc/*.fdc 制約フ ァ イルで個別に設
定し ている ク ロ ッ クは除外されます。 ブ ラ ン ク時はク ロ ッ ク周波数が最速にな る よ う な回路を合成す
る よ う に動作し ます。

Library Directories

パラ メ ータ : デ ィ レ ク ト リ ー デフ ォル ト ： ブラ ン ク

デザイ ンに含まれる Verilog ラ イブラ リ ーのデ ィ レ ク ト リ ー ・ パス を指定し ます。 フ ァ イル名と モ
ジュール名が一致し ている必要があ り ます。

Number of Critical Paths

パラ メ ータ : パス数 デフ ォル ト 値 : な し

論理合成結果のタ イ ミ ング ・ レポー ト に出力する ク リ テ ィ カルパス数を指定し ます。

Number of Start/End Points

パラ メ ータ : 数値 デフ ォル ト 値 : な し

論理合成結果のタ イ ミ ング ・ レポー ト に出力するパス数の設定です。 この値が 1 以上の場合のみに 　
[Number of Critical Paths] が有効です。

Output Netlist Format

パラ メ ータ : None / VHDL デフ ォル ト ： None

論理合成後シ ミ ュ レーシ ョ ン用のネ ッ ト リ ス ト 出力設定です。[VHDL] にする と暗号化 VHDL ネ ッ ト
リ ス ト （*.vhm） が生成されます。 本オプシ ョ ン設定に関わらず暗号化 Verilog ネ ッ ト リ ス ト （*.vm） は
生成されます。

Pipelining and Retiming

パラ メ ータ : None / Pipelining Only / Pipelining and Retiming デフ ォル ト ： Pipelining Only

論理合成中に行 う タ イ ミ ングの最適化処理 ”Retiming” （ リ タ イ ミ ング） と ”Pipelining” （パイプラ イ
ン） に関する設定です。

リ タ イ ミ ングは組み合わせ回路を移動し てレジス タ間同士の遅延量のバラ ン ス を と る よ う にする処
理です。 回路全体に対し て こ の処理が行われます。 パイプ ラ イ ン処理は主に演算回路に対し て行 う 処
理で、 回路の中間にレジス タ （パイプ ラ イ ン ・ レジス ター） を挿入する も のです。 後者では入力か ら
出力が得られる までのサイ クル数が、 RTL 記述と は異なる可能性があ り ます。

デフ ォル ト はパイプラ イ ン処理のみ、 [Pipelining and Retiming] は両方を行います。 [None] ではどち ら
も行いません。

　 　 なお、 後述の CDC_register ア ト リ ビ ュー ト を指定し たレジス ターパスには適用されません。

Push Tristates

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト （True） では、 ハイ イ ンピーダン ス 'Z' がレジス ターを介し てポー ト に出力される よ う な
記述に対し て、 ト ラ イ ステー ト 制御用レジス ターを追加し、 IO バッ フ ァ で ト ラ イ ステー ト 制御を行 う
よ う に回路を論理合成し ます （図 5-9）。

[False] では、 FPGA 内部で 'Z' が生成されないよ う な回路にな り ます。
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図 5-9. Push Tristate オプシ ョ ンの作用

Resolve Mixed Drivers

パラ メ ータ : True / False デフ ォル ト ： False

[True] を選択する と、 特定のネ ッ ト がア ク テ ィ ブな信号と VCC （または GND） から共に ド ラ イブさ
れている場合、 VCC （または GND） に固定し ます。

Resource Sharing

パラ メ ータ : True / False デフ ォル ト ： True

同一機能の回路が複数あ る場合、 使用 リ ソース数を減ら し て共用する回路を生成 （ リ ソース ・ シェア
リ ング） し ます。 [False] ではこの処理は行いません。

Resynthesize All

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト では全てのフ ァ イル / モジュールを再合成し ます。 [False] にする と、 直近の実行時から
更新された部分のみを合成し ます。

Update Compile Point Timing Data

パラ メ ータ : True / False デフ ォル ト ： False

コ ンパイルポイ ン ト （compile point） はイ ン ク リ メ ン タル ・ デザイ ンフ ローに関する機構です。 階層
構造の下位モジ ュールが変更された場合に、 デフ ォル ト （False） ではその上位モジ ュールは再合成さ
れませんが、 [True] を選択し た場合は、 上位モジュールが再び論理合成されます。 下位モジュールの変
更に伴い、 タ イ ミ ング ・ データ と タ イ ム ス タ ンプが更新されます。

Use Clock Period for Unconstrained I/O

パラ メ ータ : True / False デフ ォル ト ： False

デフ ォル ト では SDC/FDC フ ァ イルでタ イ ミ ング制約が与え られている I/O についてのみ制約を適用
し ます。 [True] にする と未制約の I/O にも仮想的な ク ロ ッ ク に対し て制約が与え られます。 

VHDL 2008

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と プロ ジェ ク ト の VHDL 言語仕様と し て VHDL 2008 を適用し ます。

5.3.2 ポス ト 論理合成のス ト ラ テジー項目

　 Post-Synthesis （論理合成プロセス後処理） のス ト ラ テジー項目には以下が含まれています。

Hardware Evaluation （Avant フ ァ ミ リーのみ）

　 パラ メ ータ : Tue / False デフ ォル ト :False

IP ラ イセン スがない場合に暫定的にテス ト する こ と を可能にし ます。[True] にする と時限タ イマーが
自動的に付加されて、 約 ４ 時間の動作が可能にな り ます。 デフ ォル ト では IP ラ イセン スがない と ビ ッ ト
ス ト リ ームが生成でき ません。
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External Module Files (.udb)

　 パラ メ ータ : （フ ァ イル名） デフ ォル ト : ブラ ン ク

論理合成済のデザイ ンが *.udb と し てあ り 、 これをデザイ ンの ト ッ プレベルに統合する こ と ができ ま
す。 ブラ ウズ し て *.udb フ ァ イルを指定し ます。

5.3.3 論理合成後のタ イ ミ ング解析 と ス ト ラ テジー項目

　 論理合成プロ セスでのタ イ ミ ング解析にははス ラ イ ス （LUT/FF） などのエレ メ ン ト 遅延、 データパスの
配線遅延、 およびク ロ ッ ク配線遅延などが関わ り ます。 エレ メ ン ト 遅延はツールにロード されている所定の
値を用いますが、データパス と ク ロ ッ ク の配線遅延については、特定のアルゴ リ ズムで推定値を使用し ます。

　 ス ト ラ テジー・オプシ ョ ンによ って タ イ ミ ング解析条件やレポー ト ス タ イル等を変更する こ と ができ ます。
ア ク テ ィ ブな ス ト ラ テジーを ダブル ク リ ッ ク し て設定ウ ィ ン ド ウ を表示 し、 左側 ”Process” 枠で ”Post-
Synthesis Timing Analysis” を選択し ます。

Number of End Points

　 パラ メ ータ : 数値 デフ ォル ト :10

ク リ テ ィ カル ・ エン ド ポイ ン ト ・ サマ リ ーでのエン ド ポイ ン ト 数を指定し ます。

Number of Paths Per Constraint

　 パラ メ ータ : 数値 デフ ォル ト :10

詳細パス レポー ト のパス数を指定し ます。

Number of Paths Per Endpoint

　 パラ メ ータ : 数値 デフ ォル ト :1

各エン ド ポイ ン ト に対する最大パス数を指定し ます。

Number of Unconstrained Paths

　 パラ メ ータ : 数値 デフ ォル ト :10

未制約パス （タ イ ミ ング制約でカバーされていないパス） のレポー ト 数を指定し ます。

Report Format

　 パラ メ ータ : Lattice Standard / Diamond Style 　 デフ ォル ト :Lattice Standard

[Lattice Standard] は業界標準ツールの書式に準じ たレポー ト ・ フ ォーマ ッ ト です。 [Diamond Style] は
既存ツール Lattice Diamond のタ イ ミ ング ・ レポー ト と同じ フ ォーマ ッ ト です。

Timing Analysis Options

　 パラ メ ータ : Hold Analysis / Standard Setup Analysis / Standard Setup and Hold Analysis

デフ ォル ト  : Standard Setup and Hold Analysis

デフ ォル ト でセ ッ ト ア ッ プ / ホール ド時間解析の両方を同時に行います。 [Hold Analysis] にする と、
ホール ド解析のみを行い、 [Standard Setup Analysis] セ ッ ト ア ッ プ解析のみを行います。

5.3.4 SCOPE エデ ィ ターによ る制約フ ァ イルの生成

　 Synplify Pro が備え る制約エデ ィ タ GUI であ る ”SCOPE エデ ィ ター ” を用いて ”Synopsis Design Constraint”
と し ての制約フ ァ イルが生成で き ます。 以下に論理合成時に適用する制約フ ァ イル ”*.fdc” （FPGA Design
Constraints） を新規に生成する方法を記述し ます。 RTL の文法エラー等はすべて解消されている もの と し ま
す。
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　 なお、Synplify Pro には sdc から fdc への変換コマン ド ”sdc2fdc” がサポー ト されていますので、 これについ
て も ド キ ュ メ ン ト をご参照 く ださい。

5.3.4.1 SCOPE エデ ィ ターの起動

　 まず Lattice Radiant から Synplify Pro GUI を立ち上げます。その後 GUI ト ッ プで左上の大き なボタ ン 『Run』
を ク リ ッ ク し て論理合成を実行するか、[Run] メ ニューから [Compile Only] を選択し てコ ンパイルのみを実行

し ます （図 5-10）。 エラーがあ る場合は、 これ以降の作業ができ ませんので、 ご注意 く ださい。

図 5-10. 『Run』 またはコ ンパイルのみを実行

　 次に メ ニューから [File] → [New...] を選択し て ”New” ウ ィ ン ド ウ を立ち上げます （図 5-11）。 fdc フ ァ イル
生成のため ”FPGA Design Constraints” を選択し、 丸印内の 「New File Name」 セルにフ ァ イル名を入力し、
「File Location」 をブラ ウズ し て指定し た後、 『OK』 を ク リ ッ ク し ます。

図 5-11. SCOPE エデ ィ タの起動

　 制約設定用ワーク シー ト ”SCOPE エデ ィ ター ” が立ち上が り ます （図 5-12）。

図 5-12. “FPGA Design Constraints” 入力用ワーク シー ト GUI



Lattice Radiant 論理合成プロセス 5-15
©2024 Macnica, Inc.

Rev.2023.2.1

　 ウ ィ ン ド ウの下部には複数のタブがあ り ます。 与えたい制約のタブを選択し た後に、 それぞれを入力し て
いき ます。

5.3.4.2 ク ロ ッ ク制約の設定

　 ク ロ ッ ク については、 [Clocks] タブを選択後に空白の ”Object” セルを ク リ ッ クする と、 その右端に▼印が

表示されます。 これを ク リ ッ ク し て現れるプルダウ ンの候補から意図する ものを選択し ます。 その後最低限
”Name” に適切な名称を、 ”Period” セルの周期 [ns] を与えます。 ”Enable” セル表示に✔印が付いている こ と
を確認し ます。 無効にする場合はこの印を消し ます。

　 プルダウ ンに意図する候補が表示されない場合は、ク ロ ッ ク と し て認識されない RTL 記述か回路設計に何
らかの要因があ り ますが、 ク ロ ッ ク ネ ッ ト やポー ト のオブジェ ク ト を RTL スケマテ ィ ッ ク ・ ビ ュー GUI か
ら ド ラ ッ グ＆ド ロ ッ プする入力方法があ り ます。 その場合は、 まず上部 メ ニューバー内の RTL ビ ューア イ コ
ン （右図の赤枠） を ク リ ッ ク し て、 RTL スケマテ ィ ッ ク ・ ビ ューを表示させます。

図 5-13. ク ロ ッ ク ・ オブジェ ク ト の選択

　 こ こ で、ビ ューの表示形式を旧バージ ョ ン相当にし たい場合は、メ ニューから [HDL Analyst] → [Use Legacy
HDL Analyst (obsolete)] を選択し ておき ます （図 5-14 左図）。

図 5-14. RTL ビ ューの起動 （右） と ” レガシー ” 表示の選択 （左）

　 次に図 5-15 右下の丸印で示す、 ビ ューの右上端にあ る ”Restore Down” ア イ コ ン （どの表示でも構わない）
を ク リ ッ ク し て、 複数のウ ィ ン ド ウ間でマウ ス移動ができ る よ う にし ます。 FPGA Design Constraints ワーク
シー ト では [Clocks] タブを選択し、 適切な表示位置に移動し ておき ます。

• RTL ビ ューの左枠で Instances や Nets 項を展開し、 意図する ク ロ ッ ク ネ ッ ト を選択し ます （図 5-15
左枠内の赤色表示は、 ク ロ ッ ク ネ ッ ト が選択された状態）

• RTL ビ ューで赤線の当該ク ロ ッ ク ネ ッ ト を ク リ ッ ク し て選択し た状態で ド ラ ッ グ し てワーク シー ト の
”Object” セルに ド ロ ッ プし ます （図内の中央上）

　 ”Name” と ”Period” などを適宜入力し ます。 これを必要な ク ロ ッ ク ネ ッ ト 分だけ繰 り 返し ます。

　 ワーク シー ト で I/O タ イ ミ ングなど、 その他について も適宜タブを選択し て入力を完了し、 保存し ておき
ます。
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図 5-15. オブジェ ク ト の ド ラ ッ グ＆ド ロ ッ プ と ウ ィ ン ド ウの個別表示ア イ コ ン （右下） 　

5.3.4.3 コ ンパイルポイ ン ト の設定

　 モジ ュールにコ ンパイルポ イ ン ト （Compile point） を設定し て論理合成する と、 特に規模の大き なデザイ
ンでは論理合成時間を短縮でき ます。 論理合成の実行時にコ ンパイルポイ ン ト ご と に作成されるデータベー
ス を参照し て、 変更されている ソース フ ァ イルのみの論理合成を行います。

図 5-16. コ ンパイルポイ ン ト ・ タ イプによ る最適化の違い

　 ”soft” はモジュール間の接続分の回路を ま と めて最適化し ます。 ”hard” の場合は接続部分の回路を コ ンパ
イルポイ ン ト ご と に個別に最適化し ます。 ”locked” では接続部分の最適化は行われません。

図 5-17. SCOPE によ る コ ンパイルポイ ン ト の設定 １

　 SCOPE ワーク シー ト で設定する場合、 [Compile Point] タブを選択後、 空白の ”View” セルを ク リ ッ クする
と その右端に▼印が表示されますので （図 5-17）、 これを ク リ ッ ク し て現れるプルダウ ンの候補から選択し
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ます。

　 次に ”Type” セルを ク リ ッ ク し、 同様にプルダウ ンから意図する タ イプを指定し ます （図 5-18）。 ”Enable”
セル表示に✔印が付いている こ と を確認し ます。 無効にする場合はこの印を消し ます。

図 5-18. SCOPE によ る コ ンパイルポイ ン ト の設定 ２

5.3.4.4 fdc 制約フ ァ イルのプロジ ェ ク ト への取り込み

　 制約フ ァ イル保存時に作業プロ ジェ ク ト に含めるかど う かを問われます。 生成が完了し た後、 プロ ジェ ク
ト 表示ウ ィ ン ド ウ （[Project Files] タブ） で図 5-19 のよ う に ”Logic Constraints (FDC)” 部にフ ァ イル名が表示
されます。 なお、 以上の SCOPE エデ ィ ターによ る作業は、 GUI 起動し て作業し た論理合成プロ ジェ ク ト の
みに対し てであ る こ と に留意する必要があ り ます。

図 5-19. 制約フ ァ イル fdc の リ ス ト 表示

5.3.4.5 fdc 制約フ ァ イルのアク テ ィ ブ化

　 作成し た fdc フ ァ イルを、Synplify Pro GUI の起動ではない、通常の Radiant フ ローにも適用される よ う にす
る 場合の手順です。 Radiant の フ ァ イ ル リ ス ト ・ ビ ュ ー内の イ ン プ リ メ ン テーシ ョ ン 下 ”Pre-Synthesis
Constraint File” セ ク シ ョ ンに *.fdc を取 り 込み、 ア ク テ ィ ブ化 （太字表示） し ます （図 5-20）。 複数あ る場合
でも、 有効 （ア ク テ ィ ブ） にでき るのは一つです。 これはイ ンプ リ メ ンテーシ ョ ンご と に行います。

図 5-20. fdc 制約フ ァ イルの取 り 込み例
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5.3.5 ネ ッ ト リ ス ト ・ アナラ イザー

　 Radiant2022.1 からは、 LSE 同様に Synplify Pro を選択し た場合でも ネ ッ ト リ ス ト ・ アナラ イザーがサポー

ト されています。 ただし テ ク ノ ロ ジー ・ ビ ューのみの対応です。 操作方法などは LSE と 同様ですので、 第
5.2.3 節をご参照 く ださい。

5.3.6 Synplify Pro ド キ ュ メ ン ト

　 Synplify Pro の使用方法やオプシ ョ ン設定に関する各種のガ イ ド ラ イ ン ・ ド キ ュ メ ン ト は、 以下のフ ォル
ダーにイ ン ス ト ールされています （Radiant 2023.2 をデフ ォル ト 設定でイ ン ス ト ールし た場合） 。 これらは、
Synplify Pro GUI の メ ニューから [Help] → [PDF Documents] でも呼び出すこ と ができ ます。

C:\lscc\Radiant\2023.2\synpbase\doc

fpga_user_guide.pdf : 主に GUI 操作を含むデザイ ンフ ロー全般についての記述

fpga_hdl_reference.pdf : HDL 言語サポー ト 機能についての詳細記述 （Verilog/VHDL/System Verilog）

fpga_attribute_reference.pdf : 論理合成ア ト リ ビ ュー ト （属性） についての記述

oem_message_reference.pdf ： エラー メ ッ セージ番号についての記述

5.4 論理合成プロセス ・ レポー ト

5.4.1 プロセス実行ロ グ

　 論理合成プロセス を実行する と、 レポー ト ・ ビ ューにレポー ト が表示されます。 GUI 上部の [Reports] タブ
を ク リ ッ ク し、 ウ ィ ン ド ウ左側のセ ク シ ョ ンで [Synthesis Reports] を ク リ ッ クする と （図 5-21）、 サブ項目五
つが リ ス ト されています。最初は Radiant 2022.1 から追加された ”Constraint Propagation” で、制約プロパゲー
ト ・ エンジンが IP や IPcatalog 生成モジュールの個別制約を抽出し て論理合成に適用し た制約の リ ス ト です。

図 5-21. 制約プロパゲーシ ョ ン ・ レポー ト

　 サブ項目の二番目が選択し ている ツールによ って ”Lattice LSE” （図 5-22） または ”Synplify Pro” です。 こ
の項目 と ”Post-Synthesis Report” 項の内容は基本的にツールの実行ロ グです。

　 LSE の場合には ”Lattice LSE” 項を選択時の右側表示内で、 右上に ”Contents” と し て三つのレポー ト 内 リ
ン ク があ り ます。 これら を ク リ ッ ク し て ク ロ ッ クやエ リ ア （ リ ソース） の表示箇所にジ ャ ンプでき ます。

　 Synplify Pro ではこの リ ン クはあ り ません。
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図 5-22. 論理合成プロセス ・ レポー ト （LSE）

5.4.2 リ ソース ・ レポー ト

　 ”Synthesis Resource Usage” 項を ク リ ッ クする と、 右側にはのよ う にデザイ ン階層ご と に使用されている リ
ソースが表形式でレポー ト されます。 階層表示はデフ ォル ト では下位階層すべて展開されていますが、 ▼印
を ク リ ッ クすれば展開し ないでその階層についての リ ソース行のみが表示されます。

図 5-23. 論理合成プロセスの リ ソース ・ レポー ト 例

　 各 リ ソース数は、 数値 と と もに ”( 値 )” のよ う に括弧付きの数値を伴っています。 これは下位モジュール
ではな く 、 当該階層そのレベルでの リ ソース数を示し ています。

5.4.3 論理合成後のタ イ ミ ング ・ レポー ト

　 ”Post-Synthesis Timing Report” 項は、 他のサブ項目の行頭が 印で閲覧可能であ る こ と を示し ているの

に対し て、 デフ ォル ト や更新後の制約条件で未実行時は 印になっていて、 有効な タ イ ミ ング ・ レポー
ト が閲覧でき る状態ではないこ と を示し ています。

　 レポー ト を出力するためには、図 5-24のよ う に”Task Detail View”ア イ コ ンを ク リ ッ クする と現れる ビ ュー
内で該当するサブプロセス ”Post-Synthesis Timing Analysis” ボ ッ ク ス を ク リ ッ ク し て有効化し てから論理合
成を実行するか、或いは論理合成を実行後にこのサブプロセスのみをダブルク リ ッ ク し て解析を実行し ます。

　 タ イ ミ ング解析レポー ト の例を図 5-25 に示し ます。 右側のレポー ト 表示内で、 右上に ”Contents” と い う
ボタ ンがあ り ます。 マウ ス ・ ポイ ン ターを この上に移動する と、 内容項目の リ ス ト を示す リ ン ク が表示され
ますので、 これら を ク リ ッ ク し て所望の表示箇所にジ ャ ンプする こ と ができ ます。
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図 5-24. 論理合成後タ イ ミ ング解析サブプロセスの実行

図 5-25. 論理合成プロセスのタ イ ミ ング ・ レポー ト

1. DESIGN CHECKING

1.1 SDC Constraints *.sdc/*.fdc 制約フ ァ イルで与え られている制約を リ ス ト し ます

1.2 Constraint Coverage 与え られている制約のカバレ ッ ジを % でレポー ト し ます

1.3 Overall Summary セ ッ ト ア ッ プ / ホール ド ・ タ イ ミ ング解析結果のサマ リ ーです。 タ イ ミ ン
グエラーのエン ド ポイ ン ト 数、及びネガテ ィ ブ・ス ラ ッ ク値の合計のレポー ト です

1.4 Unconstrained Report 各未制約パスの始点 ・終点のレポー ト です。パス数はス ト ラ テジー項目の
”Number of Unconstrained Paths” に従います。どのよ う に制約すべきかの示唆が併
記されます

1.5 Combinational Loop 組み合わせ回路のループがあ る場合にレポー ト されます。ない場合はブラ
ン ク です

1.6 Errors/Warning Messages 　 エ ラーやウ ォーニングがあ る場合のみレポー ト されます。 何も ない場
合は、 このサブ項目はあ り ません

2. Setup at User Specified Speed Grade Corner at User Specified Degrees

2.1 Clock Summary ク ロ ッ ク ド メ イ ンご と のターゲ ッ ト と その結果を レポー ト し ます。他の ド
メ イ ンからの （domain crossing） パスがあ る場合、 ス ラ ッ ク値を レポー ト し ます

2.2 Endpoint slacks エン ド ポイ ン ト 、 ス ラ ッ ク値、 ネガテ ィ ブ ・ ス ラ ッ ク の ト ータル値です
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2.3 Detailed Report セ ッ ト ア ッ プ時間詳細を、 ス ラ ッ ク の小さ い （ワース ト パスの） 順にレ
ポー ト し ます。 パス数はス ト ラ テジー項目の ”Number of Paths Per Constraint” に
準じ ます

3. Hold at User Specified Speed Grade Corner at Minimum Degrees

3.1 Endpoint slacks エン ド ポイ ン ト 、 ス ラ ッ ク値、 ネガテ ィ ブ ・ ス ラ ッ ク の ト ータル値です

3.2 Detailed Report セ ッ ト ア ッ プ時間詳細を、 ス ラ ッ ク の小さ い （ワース ト パスの） 順にレ
ポー ト し ます。 パス数はス ト ラ テジー項目の ”Number of Paths Per Constraint” に
準じ ます

5.5 論理合成 HDL ア ト リ ビ ュー ト 記述

5.5.1 CDC_Register ア ト リ ビ ュー ト

　 2023.2 か ら 新規にサポー ト さ れた ア ト リ ビ ュ ー ト です。 ク ロ ッ ク ド メ イ ン を跨ぐ パ ス （Clock-Domain
Crossing path） に メ タ ス タ ビ リ テ ィ を防ぐ同期化目的で挿入する フ リ ッ プフ ロ ッ プが、 タ イ ミ ング最適化の
ために削除 （optimize） される こ と を防ぐ と共に、 タ イ ミ ング解析および配置配線処理時の配慮がされる こ と
を可能にし ます。

　 Verilog HDL でのア ト リ ビ ュー ト 記述例は以下のよ う にな り ます。 ”int” は Avant では 1 ～ 12、 それ以外は
1 ～ 8 の整数値です。

　 　 例 １ ： 　 reg B /* synthesis CDC_Register=1 */;

　 　 例 ２ ： 　 reg [1:0] B /* synthesis CDC_Register=2 */; // 下図ではレジス タ B と C

　 １ の場合と ２ の場合を以下に示し ます。 ２ の例の場合、 レジス タ B と C は同一ス ラ イ ス内や隣接ス ラ イ ス
などの近傍に配置され、 その間の配線も最短に処理されます。

　 ただ し外部入力の同期化目的の場合は異な り ます。 ツールのデフ ォル ト 設定では同期レ ジ ス タ の初段に
IOFF が用いられるため、 後段のレジス タ と の配線は一般的に長 く な り ます。

　 本ア ト リ ビ ュー ト が与え られる と CDC パス （レジス タ A と B 間） のタ イ ミ ングは解析対象から除外され、
従って タ イ ミ ングレポー ト にも含まれな く なる こ と に、 ご留意 く ださい。

図 5-26. CDC_register ア ト リ ビ ュー ト の適用イ メ ージ

　 なお、 CDC レジス タ間、 および例 ２ の場合ではレジス タ B と C の間に論理がないこ と が要件です。

5.5.2 その他のア ト リ ビ ュー ト について

　 LSE と Synplify Pro でサポー ト するその他の HDL ア ト リ ビ ュー ト について、 詳細についてはオン ラ イ ンヘ
ルプで [Reference Guides] → [Constraints Reference Guides] → [HDL Attributes] よ り ご参照いただけます。 以
下ご参考までに、 一部について例を示し ます。
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VHDL 例

（定義し た信号 ・ ノード を論理圧縮で削除し ないで残す）

attribute syn_keep : boolean; -- ワ イヤ （ノード） の保持

attribute syn_keep of <signal_name>: signal is true; -- “signal_name” は signal 定義し た信号名

attribute syn_preserve : boolean; -- FF の保持

attribute syn_preserve of <signal_name>: signal is true; -- “signal_name” は signal 定義し た信号名

attribute syn_noprune : boolean; -- 出力がない リ ソース削除の禁止

attribute syn_noprune of <signal_name>: signal is true; -- “signal_name” は signal 定義し た信号名

（FSM のコーデ ィ ング方式）

attribute syn_encoding : boolean; -- [sequential, binary, onehot], 他に safe （”default” 記述有効化）

attribute syn_encoding of <fsm_nodes>: signal is “safe, Boolean”; --“fsm_nodes” は signal 定義し た FSM 名

Verilog HDL 例

（I/O タ イプ指定、 ポー ト 宣言行）

input CLKIN /* synthesis IO_TYPE="LVCMOS18" */ ;

output CLKOUT /* synthesis IO_TYPE="LVDS25E" */ ; 

（定義し た信号 ・ ノード を論理圧縮で削除し ないで残す。 ノード定義行）

reg [x:0] <FF_name> /* synthesis syn_preserve=1 */;

wire [y:0] <wire_name> /* synthesis syn_keep=1 */;

（FSM のコーデ ィ ング方式。 FSM ノード定義行）

reg [z:0] <FF_FSM_name> /* synthesis syn_encoding=”safe, binary” */;

更 　 新 　 履 　 歴

--- *** ---

リビジョン ページ 　　　　　内　　　容

2022.1 4, 6  Rev.3.2.1 からバージョン・アップに伴い、LSEストラテジー項目を更新
　p.4: Allow Mixed Assignmentsを追加
　p.6: Target Frequencyデフォルトをブランクから200に更新

9, 12 同、SynplifyProのストラテジー項目 “Auto Compile Point”、“Resynthesize All”を追加

17 同、SynplifyPro対応のネットリスト・アナライザーについて新規記述追加

18 同、論理合成後プロセスレポートで更新された”Constraint Propagation”について追記、画像追
加

20 同、論理合成後のタイミング解析について画像と項目・記述を更新

(r1) 18  SynplifyProエラー番号の参照ドキュメントについて追記

2023.2.1 --  2023.2へのバージョン・アップに伴う見直し・更新

9  clock_conversionアトリビュートについて追加

21  CDC_Registerアトリビュートについて追加
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